
Intime for Windows Help Contents
To learn how to use Help, press F1 or choose Using Help from the Help menu

General
PowerBar General Menus

Organizer
Opening People ToolBar
Initials Diary Printing
Sections Todo Searching
Adding Anniversary Alarm 
Deleting Notes 
Entries Convert
Closing Graphs

Accessories
Calendar Clock Alarm 

Setup
Setup Help Hardware



Power bar
The Intime Power bar is a menu system that always remains visible infront of other applications 
and is used to run applications that form part of the Intime suite of programmes.

To run the Power bar double click on the following icon 

The following will be visible in the top right of the screen and can be used to run applications by 
clicking on the relevant icons

The icons run the following applications :-

Organizer
Calendar
Alarm
World Clock
Iconeditor
Lottery
Help
Close / Exit the Power bar. 



General
Running a Application

To run a application Double click on the Icon.

Closing a Application

To Close a Application click on the box with a horizontal line in the box then select Close 
alternatively just double click on the Box. The box is located in the top left of the associated 
window.

Move Between Controls and Input Boxes

To move between input boxes etc. use the press the TAB key alternatively click on the required 
box etc. with the Mouse and select or type in the required information.

Drop Down List Boxes

To change the text in the drop down list boxes click on the down arrow with the mouse and then 
click on the required option.

Alternatively use the Up and Down arrow keys to scroll through the options or hold down the Alt 
key and press the arrow down key to display the list.



Menus

Menu location

The Menus are located at the top of the Window

Moving Around the Menus

To select a Menu item press the Alt Key, then use the Arrow keys to move Left, right, up and 
down the menus or click on the menus with the Mouse.

Fast access keys are included to access menu items with a Keyboard    i.e. Without selecting 
any of the menus hold down the Ctrl key and press A this will add a Entry.

Each Menu item has a Underlined character by Holding down the Alt key and pressing the 
relevant letter will access the Menu or button etc. i.e. Alt + C will display the Controls Menu then
press the relevant letter on the menu as required i.e. N to move to the next entry.



Opening Intime Organizer
After running the Organizer will be seen on the screen. The organizer can be opened using one 
of the following methods :-

1) Click on the Open tab 

2) Use the Menu File and then Open 

3) Press the Tab key on the keyboard Twice.



Initials
To change the initials at the bottom of the Organizer front cover Click on the letters or press the 
tab key once and delete the current initials and add your own.

When Exiting the Organizer the Initials will be saved to the Hard disk.



Sections
To change the current section in the Organizer use one of the following methods

1) Select the Sections menu and then the relevant section as required (See below).
2) Click on the relevant tabs
3) Press F5....F9 as required (See function key descriptions below).



Adding
To add additional entries in the organizer such as new people, Notes, Graphs and new Diaries 
click on the Add word located at the top of the organizer spine.

Alternatively the Entries menu can be used or Hold down the Ctrl key and press the A key.



Deleting
To delete entries in the organizer such as people, Notes, Graphs click on the Del word located 
at the bottom of the organizer spine.

Alternatively the Entries menu can be used or Hold down the Ctrl key and press the D key.

Notes :-

The last record cannot be Deleted so create a new record first



 Entries Next / Previous

Next entry

To move to the next entry in the people, Notes and Graph sections etc. click on the turned up 
corner of the right hand side page.

Alternatively the Entries menu can be used or Hold down the Ctrl key and press the N key.

Previous entry

To move to the previous entry in the people, Notes and Graph sections etc. click on the turned 
up corner of the left hand side page.

Alternatively the Entries menu can be used or Hold down the Ctrl key and press the P key.

Moving to the First / Last Entry

The Entries menu can be used to move to the first or last record.

To move to the First Entry Ctrl + F
To move to the Last Entry Ctrl + L



Closing Intime
Exit the application

To exit the application select File menu and Exit or press Ctrl + E

Alternatively double click on the control box symbol in the top left of the active window.

    Control box



Organizer People Section
Selecting the Required Section

To enter information on people select the peoples Section 

Adding / Deleting Entries

To add entries use the Add Symbol or the Entries Menu.
To delete entries use the Del Symbol or the Entries Menu.

Moving Between Entries

To move between entries either use the Next or Previous Entries or select from the alphabetical 
list on the left hand side page.

The < Symbol at the top of the list moves to the very first entry and the > Symbol at the bottom 
of the list moves to the last entry.

Selecting the Persons Title

To select a persons title click on the down arrow key and select the required title i.e. Mr or type 
in the required title if it is not in the list.

User Defined Field

To amend the user defined field label click on the label and remove the existing title and type in 
the required text for the fields label.

Searching and Printing

To search for a person see the Searching help section or to print reports see the Printing help 
section.



Organizer Diary Section
Selecting the Required Section

To enter information on dates and appointments select the Diary Section 

Adding a New Diary

To add a new diary use the Add Symbol or the Entries Menu.

Opening a Diary

When the Organizer is opened the last Diary edited will be Loaded.
To open a different Diary click on the Open Diary icon     which is located at the top of the left 
hand side page next to the date.

Moving Between Entries

To move between entries/dates either use the Next or Previous Entries or select from the 
planner on the left hand page.

Selecting the Images for the Year Planner.

To select a image for the Year planner double click on the date required on the year planner and
the Images window will be displayed, Click on the required image and the picture will be 
transferred to the Planner.

You can set four projects per year planner by editing the Blue labels.

Searching and Printing

To search for a person see the Searching help section or to print reports see the Printing help 
section.



Organizer Todo Section
Selecting the Required Section

To enter information on items Todo select the Todo Section 

Amending Entries

To amend items click on the required line and add or delete the text using the keyboard.

Moving Between Entries

To move between entries use the arrow keys or the mouse.

Order.

To view the Todo items in order enter a priority rating from 0-9 in the Order column (9 being the 
highest priority thus appearing at the top). When the priority rating is entered the entries will be 
sorted as soon as the next row is selected. This will allow other modifications the same line to 
be carried out first.

Entering Information and Selecting the Date.

To enter a date in the date column Click on the required line in the date column and type in the 
date alternatively Double click on the date section of the line and a calendar will be displayed. 
Select the date by double clicking on date in the calendar.

Searching and Printing

To search for a person see the Searching help section or to print reports see the Printing help 
section.



Organizer Anniversary Section
Selecting the Required Section

To enter information on Anniversary items i.e. Yearly occurrences    select the Todo Section 

Selecting the Month

Select the required month to be edited by using the Drop Down List Box

Amending Entries

To amend items click on the required line and add or delete the text using the keyboard.

Moving Between Entries

To move between entries use the arrow keys or the mouse.

Order by Date.

To view the Anniversary items in order enter a Day from 01-31in the Day column.    When the 
day is entered the entries will be sorted as soon as the next row is selected. This will allow other
modifications the same line to be carried out first.

Searching and Printing

To search for a person see the Searching help section or to print reports see the Printing help 
section.



Organizer Notes Section
Selecting the Required Section

To enter information on General Notes select the Notes Section 

Adding / Deleting Entries

To add entries use the Add Symbol or the Entries Menu.
To delete entries use the Del Symbol or the Entries Menu.

Moving Between Entries

To move between entries either use the Next or Previous Entries or select from the alphabetical 
list on the left hand side page.

Adding a Picture

To add a picture select the directory where the picture is located and click on the file name in the
file list box and the picture will be displayed in the Picture box. Valid pictures are WMF,BMP and 
ICO. To remove a picture click on the Remove Picture Button.

The file location to the picture is located in the box at the bottom of the right hand side 
page.

Pictures loaded into the Organizer will require the file to be present in the loaded 
directory at all times.

Searching and Printing

To search for a person see the Searching help section or to print reports see the Printing help 
section.



Organizer Conversions Section
Selecting the Required Section

To convert numbers and figures etc. select the Graph Section 

Converting Numbers

1) Select the required group from the option buttons.
2) Enter the required figure in the top text box.
3) Select the required conversion by using the Drop Down List Box
4) The answer is shown in the bottom text box.



Organizer Graph Section
Selecting the Required Section

To enter graph data and display graphs select the Graph Section 

Adding / Deleting Entries

To add entries use the Add Symbol or the Entries Menu.
To delete entries use the Del Symbol or the Entries Menu.

After adding a Entry add the required data in the Text boxes.

Moving Between Data Entries

To move between entries either use the Next or Previous Entries or select from the alphabetical 
list on the left hand side page.

Moving Between Graphs

To move between the graphs when shown on the screen use the two arrow buttons bottom left 
and right of the screen or use the Entries menu as follows.

To move to the Next Entry Ctrl + N
To move to the Previous Entry Ctrl + P

Displaying a Graph

After entering at least two Text and value items click on the graph Icon at the top left of the right 
hand side page and the graph will be displayed on the screen.

Changing Graph Types.

To change the Type of Graph Select the Types menu and select the required graph or press 
F5 .... F9. The graph must be Visible to Change the Types and Options.

The different types of graph are :-

              2D Bar chart F5
              3D Bar chart F6
              2D Pie chart F7
              3D Pie chart F8
              Line Graph F9

Changing Graph options.

The following items can be changed from the Options Menu.



Format I.e. Horizontal or Vertical bar chart etc.
Titles Sizes of text for the Main titles and Labels etc.
Legend Pie chart Legend Style and Size
Grid Horizontal Vertical None or Both.
Colours Various Colour Schemes

Searching and Printing

To print a graph you must have the graph displayed on the screen.

To search for a person see the Searching help section or to print data reports see the Printing 
help section.

Clipboard

The Graph can also be placed on the Clipboard for pasting into other Windows applications 
such as word processors, graphic packages etc.
 
While viewing the graph select the Print Menu then Clipboard Menu and the graph will be 
copied into the clipboard for pasting into other applications.



Organizer Toolbar
The Toolbar can be used to select various options in the Intime suite of programs and 
other windows accessories.

The Icon buttons have the following uses :-

Searching
Printing
Toolbar Appearance
Windows Write Application
Windows Paintbrush Application
Windows Terminal (Communications) Application
Windows Calculator Application
Intime Calendar Application
Intime World Clock Application
Intime Alarm



Printing

Selecting the Report

Click on the ToolBar icon button with the picture of a printer and the printing options 
screen will be displayed then select the following information.

1) Select the Section of the Organizer to be printed from Drop Down List Box

2) Enter the search string in the white Text Input box.

3) Select the Field to be Searched in from the Drop Down List Box

4) Select the required report from the Drop Down List Box

5) Select the order which the report is to be listed from the Drop Down List Box

6) Select if the report is to be displayed to Screen or direct to the printer from the Drop 
Down List Box

Printing the Report

Select the Print button to print the report to the screen/Printer 

The report Will be Shown to the Screen first if requested.

Print Report Icons

Once the report has been displayed on the screen the following icons will be displayed 
at the bottom of the print window.

To move between pages click on the arrow icons.
(Bottom left of the print screen)

Various layouts can be displayed by clicking on the icon with squares

Print out the report by clicking on the printer icon and enter the number of copies etc.  

Select the number of copies and pages required

Click on OK to Continue and print

To close the report double click on the square box with a line in, at the top left of the 
print report screen



Notes :-

The case icon at the bottom of the report screen is used for exporting the report to other
formats such as Microsoft Word etc.. 

If a Database Entry is changed the report must be re-produced by selecting the report 
from the Print menu etc.

Paper - All reports are set for printing on A4 paper.



Searching
Searching Options

Click on the ToolBar icon button with the picture of a Magnifying Glass and the 
searching options screen will be displayed then select the following information.

1) Enter the required search string in the text box i.e. Hill

2) Click on the square boxes to search within particular sections

3) Click on the search button or select search from the File menu

Green ticks will appear if the Text is found in the section and red crosses will appear if 
the text is not found in the section.

To goto the found text click on the relevant Tick associated with the section and the 
relevant record within the Organizer will be displayed.

At the bottom of the Organizer two mini Magnifying glasses will be displayed.

These are for further searching forwards and backwards through the section to find 
other entries associated with the text.

Notes :-

The searching facility will match both upper and lower case entries and words within 
words i.e. It will find Car within Motorcar.



Organizer Alarm

Running the Alarm 

To run the Intime Alarm click on the following bell icon on the Organizer ToolBar.

Computer System Time.

The Windows clock setting found in the control panel is used to trigger the alarm, ensure that it 
is set to the right time.

The system time is displayed in the top left of the Alarm screen

Select the Alarm Time and Reminder

To select the relevant alarm time in the alarm clock click on the down arrows on the list boxes 
and select the relevant hour and minutes.

Text can be entered into the text box to remind the user what the alarm is for.

Arming / Cancelling the Alarm

To arm the alarm click on the Set Alarm button

To Reset the alarm click on the Cancel Alarm button



Calendar Application
Running the intime Calendar.

To run the Intime calendar click on the following icon which can be found on the 
Windows program manager, on the Power bar.

Changing the displayed year.

To change the year on the Calendar use the scroll bar on the left of the screen. To 
increase the Year click on the bottom arrow or to decrease the year click on the up 
arrow.

Changing the displayed year by searching.

To locate a Year quickly use the Menu Goto.

Type in the Year required or use the scroll bar and then select OK and the calendar will 
be updated to the required year.



Clock Application
Running the intime Clock.

To run the Intime clock click on the following icon which can be found on the Windows 
program manager, on the Power bar and in the Organizer tool bar.

Computer system time.

The Windows clock setting found in the control panel must be set to GMT to display the correct 
world times.

Select World Time

To display the relevant world time on the clock click on the relevant part of the map. The red 
square marker will show the relevant place on the map to which the clock time is related.

Clock Display

The clock displayed is in 24 Hour format both in Analogue and digital clocks. The red figure i.e. -
06 states that the current location selected on the map is 6 hours behind GMT. The clock 
displays the correct time for the selected location where as the top centre of the screen displays
the System time setting (GMT).



Alarm Application

The Alarm is a totally independent alarm clock to the one found in the Organizer.

Running the Alarm 

To run the Intime Alarm click on the following icon which can be found on the Windows 
program manager, on the Power bar and in the Organizer tool bar.

Computer System Time.

The Windows clock setting found in the control panel is used to trigger the alarm, ensure that it 
is set to the right time.

The system time is displayed in the top left of the Alarm screen

Select the Alarm Time

To select the relevant alarm time in the alarm clock click on the down arrows on the list boxes 
and select the relevant hour and minutes.

Alarm Type

The alarm can sound in three different tones Phone Alarm Clock and Wrist watch, select the 
relevant ring type by clicking on the Option buttons.
 
Arming / Resetting the Alarm
To arm the alarm click on the Set Alarm button

To Reset the alarm click on the Reset Alarm button



Setup
It is recommended that all files with the extension .DLL and .VBX should be placed into the 
Windows System directory i.e. 
C:\WINDOWS\SYSTEM

It is recommended that all other files be placed in a directory called Intime on the C: drive i.e. 
C:\INTIME

It is recommended that the Alarm clock icon is added to the Startup group in windows to ensure 
that the alarm clock is initialised every time windows is used.

Load the following Icons on to the Program Manager

    Intime Menu System

 Organizer

 Calendar

 Alarm Clock    (Preferably In the Start up Window)

 World Clock

Icon Editor / Viewer

Lottery

Help Files

Should you encounter problems ensure that share is loaded this will enable file    sharing which 
is sometimes required in a Windows environment. This is only required on windows version 3.1 
or below.

Make sure that share is in the path or the path to the file is included i.e.



Enter the following line in the Autoexec.bat file

                C:\DOS\SHARE.EXE /L:500 /F5100

A Space is required before the / 



Help
Obtaining Help

Help can be accessed from the Help Menu or by pressing F1

About

Should you require further information select the About menu to Display the About screen which
details the Address and Telephone number of Quest technology

Please note that Telephone support can be a chargeable service.



Hardware
 Recommended system requirements.
    
      IBM or 100% Compatible Personal Computer

      Hard Disk. 8 Megabytes Min.
      
      Windows 3.1 and MSDOS 5.
      
      386 or above Processor and 4 Megabytes of RAM 8 recommended. (the more the better)
      
      Colour VGA screen + 256 colour display.




